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Get to know S32K116-EVB

CAN Communication Bus 1 [ LIN Communication Bus

OpenSDA USB
SBC UJA1169

External Power Supply (5-12V) OpenSDA MCU

Reset Button
Transceiver TJA1027T

OpenSDA JTAG

J2 Header
J3 Header

S32K116 MCU
J1 Header

J4 Header
J14 SWD connector.

Touch electrodes

RGB LED Potentiometer

EXTERNAL USE
User Buttons




S32K116 EVB Features:

« Supports 48LQFP and 32QFN packages
« Small form factor size 4.5” x 2.3”
* Arduino™ UNO footprint-compatible with expansion “shield” support

» Integrated open-standard serial and debug adapter (OpenSDA) with
support for several industry-standard debug interfaces

« Easy access to the MCU I/0O header pins for prototyping

* On-chip connectivity for CAN, LIN, UART/SCI.

« SBC UJA1169 and LIN phy TJA1027

» Potentiometer for precise voltage and analog measurement

« RGBLED

« Two push-button switches (SW2 and SW3) and two touch electrodes

» Flexible power supply options
* microUSB
« external 12V power supply

PR {
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Header/Pinout Mapping for S32K116

13 m PORT FUNCTION

13-02  PTBO GPIO 13-01 VBAT J2-01 PTC2 FTMO_CH2
J3-04 PTB1 GPIO J3-03 - VDD_PERH 12-02 PTC3 FTMO_CH3
J3-06 PTB6 GPIO J3-05 PTAS RESET 12-03 PTB5 LPSPIO PCS
J3-08  PTB7 GPIO 13-07 - 3.3V
13-10  PTE4 GPIO 13-09 - 5V - ﬁ_gg EIE: L':::L‘:BSS:T
J3-12  PTES GPIO 13-11 - GND = - =
J3-14  PTALl GPIO 13-13 - GND - " 12:06 PTB2 LPSPI0_SCK
316 PTD3 GPIO 13-15 - VBAT - " 12-07 - GND
L4 & J2-08 - AREF
J3 - . J2-09 PTA1 LPI2CO_SDA
" ul 12-10  PTAO LPI2CO_SCL
LJ i |
L/ [
IZB v | porr | Funcrion - :
14-02  PTC6 GPIO J4-01  PTA7 ADCO_SE3 - -
14-04  PTC7 GPIO J4-03  PTCS8 GPIO Ja EE 5
J4-06  PTCS GPIO 1405 PTC1 ADCO_SE9 ” o m
J4-08  PTCY GPIO J4-07  PTC14 ADCO_SE12 . . 11-01 DTA2 LPUARTO RX
1410  PTD5 GPIO J4-09  PTC15 ADCO_SE13 L 110 PTA3 LPUARTO TX
J4-12  PTD15 GPIO J4-11  PTC16 ADCO_SE14 =
J4-14  PTD16 GPIO 1413 PTCY GPIO J1-03 | PTAL3 FTM1_CH7
J4-16  PTE8 GPIO J4-15  PTB13 GPIO J1-04 | PTA12 FTM1_CH6
J1-05 PTDO FTMO_CH2
J1-06  PTD1 FTMO_CH3
J1-07 PTD2 FXIO_D4
J1-08 PTE9 FTMO_CH?

4  EXTERNAL USE . Arduino compatible pins
~ NXP pins *0ohm resistor is not connected



Jumper Settings

Configuration

J104

J107

J10

J108
J15

5 EXTERNAL USE

1-2

2-3 (Default)

1-2 (Default)

2-3

2-3 (Default)
1-2

1-2 (Default)
1-2 (Default)

Reset signal to OpenSDA, use to enter into
OpenSDA Bootloader mode

Reset signal direct to the MCU, use to reset
S32K116.

S32K116 powered by 12V power
source.

S32K116 powered by USB micro
connector.

MCU voltage 5v

MCU voltage 3.3v
Select LIN master option

Used for current measurement
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HMI mapping

Component | saaKite

Red LED PTD16 (FTMO CH1)
Blue LED PTE8(FTMO CH6)
Green LED PTD15(FTMO CHO)
Potentiometer PTA7 (ADCO_SER3)
SW2 PTD3

SW3 PTD5

OpenSDA UART TX PTB1(LPUARTO_TX)
OpenSDA UART RX PTBO(LPUARTO_RX)
CAN TX PTE5(CANO_TX)

CAN RX PTE4 (CANO_RX)
LIN TX PTC7(LPUART1_TX)
LIN RX PTC6 (LPUART1_RX)
SBC_SCK PTB2 (LPSPI0_SCK)
SBC_MISO PTB3(LPSPIO_SIN)
SBC_MOSI PTB4(LPSPIO_SOUT)
SBC_CS PTB5(LPSPI0_PCS1)
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S32K116 EVB
OUT OF THE BOX



Step 1: Power up the Board — EVB Power Supplies

The S32K116-EVB evaluation board powers from a USB
or external 12V power supply. By default 12V power is
enabled with J107 (check slide 5)

Connect the USB cable to a PC using supplied USB
cable .

Connect other end of USB cable (microUSB) to mini-B
port on S32K116-EVB at J7

Allow the PC to automatically configure the USB drivers if
needed

Debug is done using OpenSDA through J7

8 EXTERNAL USE M



Step 2: Power up the Board - Is it powered on correctly?

- When powered through USB, LEDs D2 and D3 should light green

- Once the board is recognized, it should appear as a mass storage
device in your PC with the name S32K116EVB.

~ Devices and drives (2)
1 05SDisk (C) 532K116EVE (D)
[ | |
|
My 74,2 GB free of 237 GB M 127 ME free of 127 MB
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Step 3: Power up the Board — Is it powered on correctly?

- Board is preloaded with a software, in
which the red, blue and green leds will
toggle at different rates.
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S32K116 JUMPSTART
EXPERIENCE
BASED ON THE
FREEMASTER TOOL



Install the FreeMASTER tool

= Download and install the FreeMASTER PC application www.nxp.com/FreeMASTER .

= Open the FreeMASTER application on your PC. You should see Welcome page:

File Edit View Esplorer Project Tools Help
SH@E B%s ek 2l 2pe o G

B I b B = = =

2 New Project]

Welcome to FreeMASTER

« What's New in Version 2.0?
See description of the most important changes and improvements implemented in this
appicatmn wversion. Connection Wizard, Active Content and gap!ucs fetched from
target memory, improved GUI and more!

« Visit FreeMASTER home page

Visit the application home page at www. freescale.com.

+ Get MCU Communication Drivers
The latest version of FreeMASTER drivers for UART, LPUART, FlexCAN, msCAN and
other interfaces s available for download at the official download page. The driver
documentation is available here.

Create New Project

« Connection Wizard NEW!
Connect to your board in few easy steps. This Wizard will help you to select
communication port or set up 3 BDM parameters to connect to your Freescale
micracontrolier board.

« Continue with this Project
Hide the welcome message and start by working with this empty project. You can
disable the weicome message for subsequent starts in the Option Settings dialog
(here)

« Open an Existing Project...
Browse your disk folders and find the project file you want to open in the FreeMASTER
environment.

More Reading
« Users Manual
Open the application manual in PDF format.

« Protocol Specification
Open the HTML Help document describing the FreeMASTER communication protocol

and host-side library. -
waicoma screan
Vanable Watch - o x
Name Value Unit L. = — Fenoﬁ
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http://www.nxp.com/webapp/sps/download/license.jsp?colCode=FMASTERSW&Parent_nodeId=1084998738637727586131&Parent_pageType=product

Power up the EVB board

13

Powers the S32K116EVB evaluation board from a
USB. By default, the USB power is enabled by JO7
jumper.

Connect the USB cable to a PC and connect micro

USB connector of the USB cable to micro-B port J7
on the S32K116EVB.

Allow the PC to automatically configure the USB
drivers if needed.

When EVB is powered from USB, LEDs D2 and D3
should light green.

The EVB board is preloaded with a software
toggling the RGB LED colors periodically between
RED-GREEN-BLUE.

EXTERNAL USE




Setup serial connection in the FreeMASTER tool

Setup communication port to “OpenSDA" and speed to 115200 b/s:

14

= Setup communication manualy:
Go to: “Project > Options > Comm*

OR

= Setup communication automatically:

Go to “Tools > Connection Wizard*

EXTERNAL USE

Comm | MAP Files | Pack Dir | HTML Pages | Demo Mode | Views & Bars |

— Communication

@ RS232  Port Iopensda L‘ IOpenSDA-CDCSer'talPort[http:fhmv.perr

Speed: |11520{} vl Timeouts... I

" Plug-in Module: I 1]

|drv=4ptype=3;pnum=1:devid=PE5011560;devl ~ |

Connect string: Configure..

[~ Save settings to projectfile [v Save settings to registry, use it as default

: File Edit View Explorer Project | Tools | Help

BT B us e

‘ Connection Wizard... "ﬁ aﬁ- x ]

Communication Debug Log...

5-Record Transfer...




The FreeMASTER JumpStart project is loaded

@ 532K116_EVE_JumpStart - FreeMASTER

: File Edit View Explorer Project Tools Help

EFHBE LRSS o BB oo o G S & N2

Pins of the 2 and J1 connectors are confizured as outputs. S32K1xx Web Links:

CONNECTOR T a‘ i CON\]ECTOR n

=> 832K Overview

=> $32K116 Evaluation Board:
> Getting Started
> 832K116EVB Quick Start Guide
> 832K 116EVB-Q048 Schematic

> §32K1xx Fact Sheet

> §32K 1xx Data Sheet
> §32K 1xx Reference Manual

> §32K1xx Product Brief
Green  Blue == SW Tools:

> FreeMASTER Run-Time Debugging Tool

> 832 Design Studio IDE

o Y i -
b CONNECTOR'T' ! %, CONNECTOR'J4 >> 832K 116 JumpStart Sources:

N+ IV el v na |Q| na:|0| 0 na|DfD

n. = = =lolle .n . > 832K116 EVB JumpStart PC Host Project

Pins of the I3 and J4 connectors are configured as inputs. = S32K116EVB JumpStart Fumware

R5232 UART Communication; COM34; speed=115200
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The FreeMASTER JumpStart project description

Pins of the J2 and J1 connectors are configured as outputs. By
single click on each pin you can change their logical level to log0
or log1. User can connect e.g. LED diodes to these ouput pins.

!

BE: o0

il

Lo
CONNECTOR ¥ % '\

Mal 4 | | Ve i

- CO_NCTOR J'l

HJlLLL sonnoonn

'zﬂOalJO

G MR - | ¢ I

Y

Pins of the J3 and J4 connectors are configured as inputs.
Logical level (log0/log1) is visualised for all connector pins.
User can connect e.g. push-button keyboard to these input pins.
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Touch Sense Electrodes

Potentiometer

S32K1xx Web Links:

=> 832K Overview

>> 832K 116 Evaluation Board:
> Getting Started
> 832K 116EVB Quick Start Guide
> 832K116EVB-Q048 Schematic
> 832K 1xx Fact Sheet
> 832K 1xx Data Sheet
> 532K 1xx Reference Manual

> 532K 1xx Product Brief
== W Tools:

> FreeMASTER Run-Tine Debugging Tool
> $32 Design Studio IDE

== 8§32K116 JumpStart Sources:
> $32K116 EVB JumpStart PC Host Project
> $32K116 EVB JumpStart Firmware

— Mechanical
Buttons

Links to S32K1xx docs:

Fact Sheet
Data Sheet
Reference Manual
Product Brief
S32K116EVB schematic
S32K116EVB Quick Start
Guide
Tools:
» FreeMASTER
« S32 Design Studio IDE
S32K116EVB JumpStart
source files

NX



The FreeMASTER JumpStart oscilloscope feature examples

= Display main project panel “View > Project Tree".

View | Bxplorer Project Tools Help

. Pioicd T Cirl+ +
Variable Watch Ctrl+E
Application Commands Ctrl+3
Variable Stimulus Ctr+C
Show Control Page as a Bar Ctrl+R

[ | A App. Commands Visibie

View Toolbar

View Variable Watch Toolbar

View Status Line
Application Layout »

= Display real-time oscilloscope graph examples such as ,Potentiometer” or ,Touch Sense Electrodes”.

17

Analog values from potentiometer.

EXTERNAL USE
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Responses from touch sense electrodes.
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INTRODUCTION TO
OPENSDA



OpenSDA is an open-standard serial and debug adapter. It bridges serial and debug communications between a USB host and an
embedded target processor. OpenSDA software includes a flash-resident USB mass-storage device (MSD) bootloader and a
collection of OpenSDA Applications. S32K116 EVB comes with the MSD Flash Programmer OpenSDA Application preinstalled.
Follow these instructions to run the OpenSDA Bootloader and update or change the installed OpenSDA Application.

Unplug the USB cable if attached
Set J104 on position 1-2.
Press and hold the Reset button (SW5)

Plug in a USB cable (not included) between a
USB host and the OpenSDA USB connector
(labeled “SDA”)

5. Release the Reset button

op -

A removable drive should now be visible in the host
file system with a volume label of BOOTLOADER.
You are now in OpenSDA Bootloader mode.

IMPORTANT NOTE: Follow the “Load an OpenSDA
Application” instructions to update the MSD Flash
Programmer on your S32K116 EVB to the latest
version.

19  EXTERNAL USE

1. While in OpenSDA Bootloader mode, double-click
SDA _INFO.HTML in the BOOTLOADER drive. A web
browser will open the OpenSDA homepage containing the
name and version of the installed Application. This
information can also be read as text directly from
SDA_INFO.HTML

2. Locate the OpenSDA Applications

3. Copy & paste or drag & drop the MSD Flash Programmer
Application to the BOOTLOADER drive

4. Unplug the USB cable and plug it in again. The new
OpenSDA Application should now be running and a
S32K116 EVB drive should be visible in the host file system

You are now running the latest version of the MSD Flash
Programmer. Use this same procedure to load other OpenSDA
Applications.
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Introduction to OpenSDA: 2 of 2

The MSD Flash Programmer is a composite USB application that provides a virtual serial port and an easy and convenient way to
program applications into the S32K116 MCU. It emulates a FAT file system, appearing as a removable drive in the host file system with
a volume label of S32K116EVB. Raw binary and Motorola S-record files that are copied to the drive are programmed directly into the
flash of the S32K116 and executed automatically. The virtual serial port enumerates as a standard serial port device that can be opened

20

with standard serial terminal applications.

Using the MSD Flash Programmer

1. Locate the .srec file of your project , file is under the
Debug folder of the S32DS project.

2. Copy & paste or drag & drop one of the .srec files to
the S32K116EVB drive

The new application should now be running on the
S32K116 EVB. Starting with v1.03 of the MSD Flash
Programmer, you can program repeatedly without the
need to unplug and reattach the USB cable before
reprogramming.

Drag one of the .srec code for the S32K116 EVB board
over USB to reprogram the preloaded code example to
another example.

NOTE: Flash programming with the MSD Flash Programmer is
currently only supported on Windows operating systems.
However, the virtual serial port has been successfully tested on
Windows, Linux and Mac operating systems.

EXTERNAL USE

1. Determine the symbolic name assigned to the S32K116EVB
virtual serial port. In Windows open Device Manager and look
for the COM port named “PEMicro/Freescale — CDC Serial
Port”.

2. Open the serial terminal emulation program of your choice.
Examples for Windows include Tera Term, PuTTY, and
HyperTerminal

3. Press and release the Reset button (SW5) at anytime to
restart the example application. Resetting the embedded
application will not affect the connection of the virtual serial
port to the terminal program.

4. ltis possible to debug and communicate with the serial port
at the same time, no need to stop the debug.

NOTE: Referto the OpenSDA User’s Guide for a description of a known
Windows issue when disconnecting a virtual serial port while the COM
port is in use.

h

P


http://logmett.com/index.php?/download/tera-term-475-freeware.html
http://www.chiark.greenend.org.uk/%7Esgtatham/putty/download.html
http://www.hilgraeve.com/hyperterminal/
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Download S32DS

Download S32DS from:

o32DS for ARM

22  EXTERNAL USE


https://www.nxp.com/support/developer-resources/run-time-software/s32-design-studio-ide/s32-design-studio-ide-for-arm-based-mcus:S32DS-ARM?tab=Design_Tools_Tab

CREATE A NEW
PROJECT IN S32
DESIGN STUDIO




Create New Project: First Time — Select a Workspace

- Start program: Click on “S32 Design Studio for ARM v2.0” icon
- Select workspace:
- Choose default (see below example) or specify new one

- Suggestion: Uncheck the box “Use this as the default and do not ask again”
- Click OK

i !
= Eclipse Launcher u

Select a directory as workspace

532 Design Studio for ARM uses the workspace directory to store its preferences and development artifacts.

‘Workspace: C\Users\B523 21 \workspace - Browse...

[] Use this as the default and do not ask again

» Recent Workspaces

[ ok || Cconcel
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Create New Project: Top Menu Selection

- File — —Project

= waorkspace ¢ C+ :
Edit Scurce Refactor Mavigate Search Project Run  ProcessorExpert  Window Help
New Alt+Shift+N » | [ & 532D5 Application Project v Bl v ve e Quick Access || [ [i=ES
Open File... = 53205 Library Project .
: = el i (@) Build Targets =
(3 Open Projects from File System... ¢ 532DS Project from Example = o= Qutline &% (@) Build Targets =
-
Close Ctrl+ W Maleefile Project with Existing Code A othne i notavalable
Close All Ctrl+ Shift+ W C++ Project
Save Ctrl«S [€] CProject
SaveAs.. @ C/C++ Project
o o .
Sava Al CHiLSRifLS ;- 532D5 Application Project
Rt &5 53205 Library Project
™ Project...
Move... _
Rename... B2 Convert to a C/C++ Project (Adds C/C++ Mature)
=i
Refrech Es 2%  Source Folder
Convert Line Delimiters To 3 fj Fakder
|£|<" Seource File
Print... Ctri+P @ LeaderFile
Switch Workspace » | [ File from Template
Restart & Class
fag Import... ™  Bample..
iy Export.. i Other... Ctrl+M
Properties Alt+Enter
1 main.c [532K144 Rev2 EVB_CAM FD_LCD..]
2 led_func.h [S32K144 Rev2 EVE CAMN_FD..]
Exit ) Console & [C] Properties KE Bebugger Consale
+ Settings FreeRTOS Task Aware Debugger Console
R -
-
T
%’.
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Create New Project: S32DS Project

= New 53205 Application Project

Create a 532 Design Studio Project

* P rOj eCt N a m e : 532D5 Application Project

Project name:

- Example: FirstProject - ==

Use default location

L ]
) P rOJ e Ct I y p e " Location: | CAlUsers\nxa1268%workspaceS32D5 ARM\FirstProject
L

Processors: ToolChain Selection:

|_t}'PEﬁ|te"tE’¢ Core Kind Mame Toolchain

Select from insid
e eC ro I n S I e 5 (= Family KEA MOplus Cortex-M0+ Standard 53205 toolchain for ARM

v (= Family 532K1xx

executable or library folder sioe

B s3Ki4z
B s3kiiz

i N eXt B s32K146
H s32K116 Description:
» (= Family MAC5TD S0 GCC toolchain is selected
» (= Family 532V

@ ‘ gt | [ Coneel |

PR {
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Create New Project: S32DS Project

- Select Debugger Support and Library Support
- Click Finish

= New 53205 Application Project O
New 532DS Project for 532K116

Select required cores and parameters for them.

Project Name FirstProject

Core Cortex-MO+

Library EWL

1/0 Support No I/0

FPU Support Toolchain Default

Language T

SDKs

Debugger PE Micro GDB server

@ finish || Cancel
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OpenSDA Configuration

- To Debug your project with OpenSDA, it is necessary to select the OpenSDA in the
Debug Configuration.

- Select your project, and click on debug configuration

workspaceS32DS.ARM - C/C++ - FirstProject/sre/main.c - $32 Design Studio for ARM
File Edit Source Refactor Navigate Search Project Run ProcessorExpert Window Help

BBl B8 E @ @G ik O A S PSRBT G D

- ( ¢l i
&) maine 12 no launch history

[ Project Explorer 52

= O geOutfine )} @ BuildTar. = O

~ (5 FirstProject: Debug lementati Debug As >
il Includes Debug Configurations... = _S32K16h
(2 Project_Settings S i s ] Organize Favorites... ® main(void) : int
(2 include # COUNTER_LIMIT
2 src int main{void)
{
#define COUNTER_LIMIT 168
int counter = 8;
for(;;) {
countert+;
if(counter > COUNTER LIMIT) {
counter = 8;
}
}
/* to avoid the warning message for GHS and IAR: unreachable®/
#if defined (_ghs )
#pragma ghs nowarning 111
#endif
#if defined [(_ ICCARM_ )
#pragna diag suppress=Pelll
sendif
return @;
I
4 Dashboard £ =
~ Project Creation ~ Settings
i New 53205 Project from Example T B Console 33 [F] Properties Bl Debugger Console 23 Disasse bR ftBE--= 0
¥ 53205 Application Project Processor Expert
{ 53205 Library Project Mar 21, 2818 3:22:84 PM Starting Processor Expert service
: = System directory = C:\NXP\S32DS_ARM_v2.@\eclipse\ProcessorExpert
= Miscella AR
— e Internal cache directory = C:\ProgramData\Processor Expert\PECache\c7b78425
(Al P Getting Started  processor Expert license file = not used (no license file)
(a1 @ Quickeccess  Mar 21, 2818 3:22:85 PM Successfully started Processor Expert service ‘
< >

L3 3items selected




OpenSDA Configuration

- Select the Debug configuration under GDB PEMicro Interface Debugging
- Click on Debugger tab

= Debug Configurations - [Tz

Create, manage, and run configurations

x| 5 - MName: FirstProject_Debug

| type filter text (Bl Main %5 Debugge
[E] €/C++ Application Project:
[€] C/C++ Remote Application
[] GDB Hardware Debugging FirstProject Erowse
2 [ GDB PEMicro Interface Debugg T =l
[ FirstProject_Debug Specify the number of additional ELF Files you wish to program: 0 |Generate ELF Fields
B FirstProject_Debug_RAM
[ FirstProject_Release
[€] GDB SEGGER J-Link Debugging
B Launch Group

Common | 38 05 Awareness |

C/C++ Application:

Debug/FirstProject.elf

[ variables... | [SearchProject...| [ Browse.. |
Build (if required) before launching
Build Configuration: | Debug -]
Enable auto build ) Disable auto build
| Use workspace settings Configure Workepace Settings...
= W v
Revert

Filter matched 9 of 11 iterms

@ [ bebug ||  Close
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OpenSDA Configuration

- Select OpenSDA as the interface, if your board is plugged should appear in the
Port field.

- Click Apply and debug to finish.

= Debug Configurations

Create, manage, and run configurations

(1, Plugin has not been registered. Some functionality may not be available.

2X| B3
| type filter text | [ B main (35 Debugge?\hﬁv Startup | % Source| 7] Common | 88 OS5 Awareness |
C/C++ Application Software Registration n
C/C++ Remote Application
[T] GDB Hardware Debugging
v m GDB PEMicro Interface Debugging
[ FirstProject_Debug
E FirstProject_Debug_RAM PEMicro Interface Settings
[ FirstProject_Release F e
GDB SEGGER J-Link Debugging E
= Launch Group Port: |usB1 - OpenSDA (F728TEOT)

\_: Name: | FirstProject_Debug

Please register your software to remove this message.

Register now |

Interface: | OpenSDA Embedded Debug - USE Port

| Select Device|  Vendor: NXP

Core: M0 ~
Specify IP Specify Network €3
Additional Options

[[]1Emergency Kinetis Device Recovery by Full Chip Erase [] Use SWD protocol
: ;Qd\;'ance.t.i-b.éti;)ns :

Hardware Interface Power Control (Voltage --> Power-Out Jack)

Provide power to farget Regulator Output Voltage Power Down Delay ms
Douner off tarnet ninnn soffuare svit 940 D Lin Pl A
— = =
Filter matched 9 of 21 items 8 = Al PELI
® Debug Close |
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- Debug configuration is only required once. Subsequent starting of debugger does
not require those steps.

- Three options to start debugger:
- If the “Debug Configuration” has not been closed, click on “Debug” button on bottom right
- Select Run — Debug (or hit F11)  noes T e e

| %&£, Debug Iy F11
f' L& Fl & pPrafile

Note: This method currently selects the desktop target (project.elf) and gives an error. Do
not use until this is changed.

- Recommended Method.: Click on pull down arrow for bug icon and select ... _debug.elf
target

Help

A~ -~ O~ ~Q - = 5 -
| [E] 1 FirstProject Debug_ PME I
[ 3 ':LI:-»E T

Debug As

Drebug Configurations...
COrganize Favorites
r——
& o- dpt mainlvoid)

h
P
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Debug Basics: Step, Run, Suspend, Resume
. Step Into (F5) R

[ step Into (75) §

. Step Over (F6) ST

Step Over (F6)

- Step Return (F7) R S

ictor Mavigate Search iject Ru Window Help

° Run T B ﬁngqv@@;

n FirstProject.elf

tor MNavigate Search

. Suspend W e

- Resume (F8)
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Debug Basics: View & Alter Variables

- View variables in “Variables” tab.
- Click on a value to allow typing in a different value.
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Debug Basics: View & Alter Registers

- View CPU registers in the “Registers” tab

- Click on a value to allow typing in a different value
- View peripheral registers in the EmbSys Registers tab = vease = crcarpomts i regimcers = [ moaues

Name Value

4 ¥ General Registers
148 r0 3
AT rl =1
3 i r2 536866944

3i8% r3
1010

_—-e ko e BN L = TR L kg
€,==" Expressions (%)= VYariables ©g Breakpoints ?ﬁ Peripherals @, Modules 7 EmbSys Registers 53 | =4 |
B Arch: cortex-m0 Vendor: Freescale Chip: SKEAZ1284 Board: --- none ---
Register Hex Bin Reset Access  Address Description i
a4 = IRQ Interrupt
| a 5C 0200 00000000 0200 Rw 040031000 Interrupt Pin Request Status and Co |5
E IRQMOD (bit 0) 00 o] & 0: IRQ event is detected onlby on 1
E IRQIE (bit 1) Dl i Q Q: Interrupt request when IRQF s¢
[=] IRQACK (bit 2) 03 0 IRQ Acknowledge
E IRGF (bit 3) 00 i) & 0: Mo IR request
E IRQPE (bit 4} 00 o & 0: IRQ pin function is disabled.
E IRQEDG (bit 5) Oz 0 & 0: IRQ is falling-edge or falling-e
E IRQPDD (bit &) 00 0 & 0: IRQ pull device enabled if IRQF
E RESERVED (bit 7} [aF] (i no description available i
L e me »___r._n__..._;l___.pr___._ "
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Debug Basics: View & Alter Memory

- Add Memory Monitor

- Select Base Address

E) Console =] Tasks [°l Problems #3 Executables | [J Memory 3

%)% %
Ly

[ Add Memoary Monitor h

= Monitor Memory d

Enter address or expression te moniter:

] | 0x20000000 vl
to Start at : 0x20000000
@ [ ok ]| cance |
® VieW Memory B Console ] Tasks [*] Problems 3 Executables [} Debugger Console (] Memory 32 D= Outline
Menitors = K S& ' 0x20000000 : 020000000 <Hex> 57 e Mew Renderings..n
@ (20000000 Address @ -3 4 -7 8 - B C-F
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2e0ce000 [ELliial] ©0000000  0ROGEE0R  PEEOEEER
20000010 ©G000R02  QOOOOOOE  0POGGGEE  DPROOOOR
200PPA20 ©0G00OROR  QOOOOR00  00OGGEEE  PPPREEAR




Debug Basics: Breakpoints

Add Breakpoint: Point and Click
- light blue dot represents debugger breakpoint

[€] main.c &3
# * main implementation: use this 'C' sample to create your own application[]

#include "532K116.h™ /* include peripheral declarations 532K116 */

int main(wvoid)
1

#define COUNTER_LIMIT lee
int counter = @;

for(;;) {
counter++;

if(counter > COUNTER_LIMIT) {
counter = 8;

i

i
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Debug Basics: Reset & Terminate Debug Session

- Reset program counter

- Terminate Ctl+F2() T
[Te

rminate (Ctrl+F2) |
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CREATE A P&E DEBUG
CONFIGURATION
(OPTIONAL)



New P&E debug configuration

- Click in debug configurations

== workspace53205.ARM - C/C++ - FirstProject/src/main.c - 532 Design Studio for ARM

File Edit Source Refacter MNavigate

iB-HB B-& - BigITiEIN

[ Project Explarer 52

~ [ FirstProject: Debug
5 @l Includes
> [ Project_Settings
> B2 include
> B sre

4 Dashboard 3

~ Project Creation
ew roject from Example
New 53205 Praject from Exampl
L7 53205 Application Project
ibrar roject
= 53205 Library Praj

~ Build/Debug
| (a1
v (A
£

<

13 3 items selected
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Search Project Run ProcessorBxpert Window Help

EG:{> =g

s vE g

~ Settings

£

~ Miscellancous
#9 Getting Started
@ Quick sccess

pt

& [ @

HFrO - Id A SRE [T - &l
@ mane 2 (no launch history)
@ * main implementati Debug As >

|
#include "S32K116.h" Organize Favarites... ions 532K116 */

~int main(void)
#define COUNTER_LIMIT 100
int counter = 8;

for(s;) {

counter++;

if(counter > COUNTER_LIMIT) {
counter = &;
1

}

#if defined (_ghs_)

#pragna ghs nowarning 111
#endif

ems &

& Console 32 [ Pram

Processor Expert

fte your own application[]
\

/% to aveid the warning message for GHS and IAR: statement is unreachable®/

8% Outline 53 (&)

- bes
[onced | s | [ 4
dTar. = 0

BB ek v
o S3K16h
L)

#

main(void) : int
COUNTER_LIMIT

o Bepm=s 5

Mar 21, 2018 3:22:84 PM Starting Processer Expert service

System directory = C:\NXP\532DS_ARM vZ.8\eclipse\ProcessorExpert

Internal cache directory = C:\ProgramData\Processor Expert\PECache\c7b78425
Processor Expert license file = not used (no license file)

Mar 21, 2018 3:22:85 PM Successfully started Processor Expert service




New P&E debug configuration

- Create a new P&E launch configuration

Click to create a new
P&E launch
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Click on the debugger tab.

= Debug Configurations

Create, manage, and run configurations

ER A=

|typeﬁlter text

[T] C/C++ Application

Mame: | FirstProject

Main . %5 Debuggea = Startup] By Source] i=| Qommon] &5 os Awarenaﬂ

- Project
[©] C/C++ Remote Application
[£] GDB Hardware Debugging | FirstProject | | Browse... |
v E GDB PEMicro Interface Debugging
E FirstProject Debug Specify the number of additional object files you wish to program: 1} | |Generate Object File Fields |
[£] GDB SEG(ER J-Link Debugging
= Launch Group
C/C++ Application:
DebughFirstProject.elf |
Variables... | | Search Project... | | Browse... |
Build (if required) before launching
Build Configuration: |5elect Automatically V|
(_) Enable auto build () Disable auto build
(®) Use workspace settings Configure Workspace Settings...
Revert A
Filter matched 7 of 19 items = PPl
® Debug | | Close




New P&E debug configuration

42

» Select the device

(1, Plugin has not been registered. Some functionality may not be available.

= ]

CEX B3~

| type filter text |

Filter

[E] C/C++ Application
[E] C/C++ Remote Application
[£] GDB Hardware Debugging
v GDB PEMicro Interface Debugging

[£] GDB SEGGER J-Link Debugging
= Launch Group

[ FirstProject Debug

Select
device

matched 7 of 19 items

Name: | FirstProject Debug

-;.__b‘ Star{u;ﬂ E'y Source

Software Registration
Please register your software to remove thy

i | Register n;]

PEMicro Interface Settings

Interface: | USE Multilink, USB Multilink FX, B
Port: |USB1 - Mulfilink Universal Rev C
Select-l)!!\-l'ice.la Vendor: Famil
Core: Mo e

Specify IP Specify

Additional Options
[[]Emergency Kinetis Device Recovery by Full Chij

Advancer}'ﬂpﬁuns.

Hardware Interface Power Control (Voltage --> Pol

[ Provide power to target Regulator|

[ Powseer aff tarnet 1inon saf evit 3L

v Select Target Device

Allowed wildcard characters:
*=Match 0 or more characters, 7=Match exactly one character

| type filter text

v NXP
o KEx
» MACSTD e

532K142F256M15
532K144F512M15
532K144F512M150NTTP
S3Z2K146FTMOMT1
S32K148F2MOMT1

> 532Viox

w &
S32K116F128M4
K178F 25604

Select

| ! Cancel

©

» Click Apply and debug your application
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USEFUL LINKS




« Cookbook application note. This application note contains a
bunch of simple examples of how to use different
peripherals.

o S32K1xx community. Visit this site for request support on
the S32K1xx products, you can also look for threads that
may contain the answer that you are looking for.
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https://www.nxp.com/docs/en/application-note/AN5413.pdf
https://community.nxp.com/community/s32/s32k
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